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 Introduction:    
      The educational program is a well-planned set of courses that include 
procedures and experiences arranged in the form of an academic syllabus. 
Its main goal is to improve and build graduates' skills so they are ready for 
the job market. The program is reviewed and evaluated every year through 
internal or external audit procedures and programs like the External 
Examiner Program. 

    The academic program description is a short summary of the main 
features of the program and its courses. It shows what skills students are 
working to develop based on the program's goals. This description is very 
important because it is the main part of getting the program accredited, 
and it is written by the teaching staff together under the supervision of 
scientific committees in the scientific departments.   

    This guide, in its second version, includes a description of the academic 
program after updating the subjects and paragraphs of the previous guide 
in light of the updates and developments of the educational system in Iraq, 
which included the description of the academic program in its traditional 
form (annual, quarterly), as well as the adoption of the academic program 
description circulated according to the letter of the Department of Studies 
T 3/2906 on 3/5/2023 regarding the programs that adopt the Bologna 
Process as the basis for their work. 



 

 

 
2 

 
  

   In this regard, we can only emphasize the importance of writing an 
academic programs and course description to ensure the proper functioning 
of the educational process. 
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          Concepts and terminology:  

 

            Academic Program Description: The academic program description provides a 
brief summary of its vision, mission and objectives, including an accurate description 
of the targeted learning outcomes according to specific learning strategies.  
Course Description: Provides a brief summary of the most important characteristics 
of the course and the learning outcomes expected of the students to achieve, 
proving whether they have made the most of the available learning opportunities. It 
is derived from the program description. 
Program Vision: An ambitious picture for the future of the academic program to be 
sophisticated, inspiring, stimulating, realistic and applicable.  
Program Mission: Briefly outlines the objectives and activities necessary to achieve 
them and defines the program's development paths and directions. 
Program Objectives: They are statements that describe what the academic 
program intends to achieve within a specific period of time and are measurable and 
observable. 
Curriculum Structure: All courses / subjects included in the academic program 
according to the approved learning system (quarterly, annual, Bologna Process) 
whether it is a requirement (ministry, university, college and scientific department) 
with the number of credit hours.  
Learning Outcomes:  A compatible set of knowledge, skills and values acquired 
by students after the successful completion of the academic program and must 
determine the learning outcomes of each course in a way that achieves the 
objectives of the program.  
Teaching and learning strategies: They are the strategies used by the faculty 
members to develop students’ teaching and learning, and they are plans that are 
followed to reach the learning goals. They describe all classroom and extra-
curricular activities to achieve the learning outcomes of the program.  



https://v3.camscanner.com/user/download
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1. Program Vision   
This course description provides a necessary summary of the most important 
characteristics of the program and the educational outcomes that the student is 
expected to achieve, demonstrating whether he has made the most of the 
available opportunities, and this must be linked to the program description. 

 

2. Program Mission 
Embodying the ethics of technical education by providing high-quality technical 
education that seeks to develop human knowledge and skills that are compatible 
with the changes occurring in the environment and society. 

 

3. Program Objectives 
1- The student knows the dental laboratories and equipment’s 
2- The student Learns and practice the principles and theories of laboratories. 
3- The student Learns how to maintenance and sustainment the devices in it. 
4- The student learns the ways and methods of storing the materials and 
equipment’s in it. 
5-The student learns the plans necessary to design and furnish these 
laboratories. 

 

4. Program Accreditation  
None 

 

5. Other external influences  
None 
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6. Program Structure 
Program Structure  Number of 

Courses  
Credit hours Percentage Reviews* 

Institution 
Requirements  

    

College 
Requirements 

    

Department 
Requirements  

    

Summer Training     
Other      

* This can include notes whether the course is basic or optional.  

 

 

8. Expected learning outcomes of the program 
Knowledge  
Learning Outcomes 1 Knowledge objectives 

1- The student must have seen with his own eyes and learn about 
dental devices and tools. 
2-The student should know the types and dental laboratory 
departments. 
3- The student must know how laboratory management. 
4- The student must have learned how laboratory equipment repair. 

Skills  
Learning Outcomes 2 1.Creation special mental skill for the student about how utilize dental 

devices. 

2- Learning to replace alternatives for parts that unemployed. 

3-Learning about the modifications of some devices 

Learning Outcomes 3 Learning Outcomes Statement 3 

7. Program Description  
Year/Level Course Code Course Name Credit Hours 
First academic 
year 

Laboratories and 
Equipment’s 

Laboratories and 
Equipment’s 

theoretical practical 
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Ethics   
Learning Outcomes 4 Emotional and value goals 

1- Participation in scientific conferences. 

2- Developing special creative abilities such as literature and art. 

3- Developing social ties through scientific trips and seminars. 

4- Participation in making illustrations such as pictures and scientific 

diagrams. 

Learning Outcomes 5 Learning Outcomes Statement 5 

 

9. Teaching and Learning Strategies  
1-Scientific lectures 2- Practical laboratories 3- Ocular observations of 
laboratory equipment’s and tools 

 

10. Evaluation methods  
1- Daily tests 2 - Semester tests 3- Final tests 

 

11. Faculty  
Faculty Members 
Academic Rank  Specialization  Special 

Requirements/Skills 
(if applicable)  

Number of the teaching 
staff  

General   Special    Staff  Lecturer   

Assistant lecturer Prosthodontic Prosthodontic   Staff  

 
Professional Development 
Mentoring new faculty members 
View updates about the curriculum 
Professional development of faculty members 
Intensifying courses and workshops for the complete kit 
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12. Acceptance Criterion  
Central admission 

 

13. The most important sources of information about the program  
1- Dental devices and laboratories book. 
2- Principles of dental laboratories and equipment’s. 

 

14. Program Development Plan  
Identify the most new important devices in dental laboratories. 
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• Please tick the boxes corresponding to the individual program learning outcomes under evaluation. 

Program Skills Outline 
 Required program Learning outcomes  

Year/Level Course 
Code 

Course 
Name 

Basic or 
optional  

Knowledge    Skills  Ethics  

A1 A2 A3 A4 B1 B2 B3 B4 C1 C2 C3 C4 
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Course Description Form 

1. Course Name: 
Laboratories and Equipment’s 

2. Course Code:  
Laboratories and Equipment’s 

3. Semester / Year: 
Courses 

4. Description Preparation Date: 
1/2/2024 

5. Available Attendance Forms:  

Direct attendance 

6. Number of Credit Hours (Total) / Number of Units (Total) 

90 hour 

7. Course administrator's name (mention all, if more than one name)  

Name: Zahra Hussein abdalateef 
Email: zahraa.almosawie.inj@atu.edu.iq 

 

8. Course Objectives  
 1- The student knows the dental laboratories and 

equipment’s 
2- The student Learns and practice the principles and 
theories of laboratories. 
3- The student Learns how to maintenance and 
sustainment the devices in it. 
4- The student learns the ways and methods of storing 
the materials and equipment’s in it. 
5-The student learns the plans necessary to design and 
furnish these laboratories. 

9. Teaching and Learning Strategies  
Strategy 1-Scientific lectures 2- Seminars and laboratories 3- Educational 

clinic 

 

 

 

10. Course Structure 
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Week Hours     
First 3 A historical 

overview of the 
history of 
dentistry 

Laboratories and 
Equipment’s 

Lecture +Lab  
 
         

Examina
tion 

Second 3 Dental 
laboratory 
departments and 
ingredients. 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Third 3 Correct use for 
tools and devices. 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Fourth 3 Cutting, carving 
and measuring 
instruments. 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Fifth 3 Mechanical and 
hydraulic 
machines, casting 
and surveying 
machines. 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Sixth 3 Melting , casting 
and manual 
cutting devices. 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Seven 3 Compressed air 
generators and 
air vacuums. 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Eight 3 Electric saw, 
vibrator and 
electric hammer. 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Nine 3 Wax and agar 
defrosting 
devices. 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Ten 3 Trimmer device Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Eleven 3 Ordinary lathe 
device 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Twelve 3 Metal lathe 
device 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Thirteen 3 Hand piece 
device and its 
motor 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Fourteen 3 Parts and 
methods use of 
hand piece device 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Fifteen 3 Sand blast 
machine 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Sixteen 3 Work in the 
gypsum materials 
lab 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Seventeen 3 Work in an acrylic 
lab 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Eighteen 3 Work in chrome –
cobalt lab 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 
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Nineteen 3 Work in crown 
and bridge lab 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Twenty 3 Work in 
orthodontics lab 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Twenty one 3 Work in maxilla 
facial lab 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Twenty two 3 Methods of dental 
materials storage 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Twenty three 3 Methods of 
dental 
equipment’s 
storage 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Twenty four 3 Lab 
management 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Twenty five 3 Reaper the 
laboratory 
equipment 

Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Twenty six 3 Slide shear Laboratories and 
Equipment’s 

Lecture +Lab Examination 

Twenty seven 
to thirty 

3 seminars’ Laboratories and 
Equipment’s 

Lecture +Lab Examination 

11. Course Evaluation 
Distributing the score out of 100 according to the tasks assigned to the student such as daily 
preparation, daily oral, monthly, or written exams, reports .... etc  

12. Learning and Teaching Resources  
Required textbooks (curricular books, if any) 1-Dental laboratory and devices 

2-Principlesof dental laboratory and 
devices 

Main references (sources)  

Recommended books and references (scientific 
journals, reports...) 

Dental laboratory and devices book for Dr. 
Fayes fouad (1985) 

Electronic References, Websites  
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Course Description Form 

13. Course Name: 
Movable acrylic partial denture 

14. Course Code:  
Movable acrylic partial denture 

15. Semester / Year: 
2023- 2024 

16. Description Preparation Date: 
1/2/2024 

17. Available Attendance Forms:  

Direct 
18. Number of Credit Hours (Total) / Number of Units (Total) 

150 hour 

 

19. Course administrator's name (mention all, if more than one 
name)  

Name: baeda hasoon salman  
Email:  albaedahasoon@gmail.com 

20. Course Objectives  
Course Objectives Cognitive objectives 

1- How to use the tools and devices in the partial denture 
2- Understand and learn about occupational safety 

before and after graduation 
3- Applying the theoretical aspect with practical steps 
4- Good dealing with patients 
5- Good dealing with patients 

Course-specific skills objectives 
1- Developing the student’s skill to use tools 
2- Developing the skill of making a clamp 
3- Creating the skill of designing the partial kit 

21. Teaching and Learning Strategies  
Strategy  

Lectures - seminars - computer presentation - scientific films 
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22. Course Structure 
week Hours Required learning 

Outcomes 
Unit or 
Subject name 

Learning  
method 

Evaluation 
method 

first 5 
Hours 

Introduction to the 
history of partial 
denture work 

Removable 
partial denture 

Lecture + lab 
 

Examination 

second 5 
Hours 

Identify the partial 
denture and its 
types 

Removable 
partial denture 

Lecture + lab 
 

Examination 

Third 5 
Hours 

Identify materials 
used in partial 
dentures 

Removable 
partial denture 

Lecture + lab 
 

Examination 

Fourth 5 
Hours 

Identify primary 
impression type 
properties 

Removable 
partial denture 

Lecture + lab 
 

Examination 

Fifth 5 
Hours 

Definition study 
cast purpose & 
landmarks 

Removable 
partial denture 

Lecture + lab 
 

Examination 

Sixth 5 
Hours 

Definition special 
tray & purpose 

Removable 
partial denture 

Lecture + lab 
 

Examination 

Seven 5 
Hours 

Definition master 
cast & material 
used 

Removable 
partial denture 

Lecture + lab 
 

Examination 

Eight 5 
Hours 

Kenndy 
classification for 
partial denture & 
modification 

Removable 
partial denture 

Lecture + lab 
 

Examination 

Nine 
Ten 
Eleven 

5 
Hours 

Component parts 
of partial denture 
function of each 
part 

Removable 
partial denture 

Lecture + lab 
 

Examination 

Twelve 5 
Hours 

Definition of 
surveyor 
&benefition 

Removable 
partial denture 

Lecture + lab 
 

Examination 



 

 

 
15 

 
  

Thirteen 5 
Hours 

Lower major 
conector type &use 

Removable 
partial denture 

Lecture + lab 
 

Examination 

Fourteen 5 
Hours 

upper major 
conector type &use 

Removable 
partial denture 

Lecture + lab 
 

Examination 

Fifteen 5 
Hours 

Wire used in clasp 
requirement  

Removable 
partial denture 

Lecture + lab 
 

Examination 

Sixteen 5 
Hours 

Definition type of 
clasp  

Removable 
partial denture 

Lecture + lab 
 

Examination 
 
 

Seventeen 5 
Hours 

Construction of 
partial denture 
base material type 
& requirement  

Removable 
partial denture 

Lecture + lab 
 

Examination 

Eighteen 5 
Hours 

Centric jaw relation  Removable 
partial denture 

Lecture + lab 
 

Examination 

Nineteen 5 
Hours 

Articulation Removable 
partial denture 

Lecture + lab 
 

Examination 

Twenty 5 
Hours 

Arrangement teeth Removable 
partial denture 

Lecture + lab 
 

Examination 

Twenty  
One 

5 
Hours 

Flasking procedure Removable 
partial denture 

Lecture + lab 
 

Examination 

Twenty 
Two 

5 
Hours 

Deflasking 
procedure 

Removable 
partial denture 

Lecture + lab 
 

Examination 

Twenty 
Three 

5 
Hours 

Finishing 
&polishing of 
partial denture  

Removable 
partial denture 

Lecture + lab 
 

Examination 

Twenty 
Four 

5 
Hours 

Repair partial 
denture  

Removable 
partial denture 

Lecture + lab 
 

Examination 

Twenty 
five 

5 
Hours 

Definition 
immediate partial 
denture 
 

Removable 
partial denture 

Lecture + lab 
 

Examination 
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Twenty 
Six 

5 
Hours 

Labratory errors of 
the the partial 
denture  

Removable 
partial denture 

Lecture + lab 
 

Examination 

Twenty 
seven 

5 
Hours 

Scientific seminars 
for students 

Removable 
partial denture 

Lecture + lab 
 

Examination 

Twenty 
Eight 

5 
Hours 

Flexible partial 
denture  

Removable 
partial denture 

Lecture + lab 
 

Examination 

Twenty  
Nine & 
Thirty  

5 
Hours 

Showing slide 
&revision of the 
whole subject  

Removable 
partial denture 

Lecture + lab 
 

Examination 

 
23. Course Evaluation 

Distributing the score out of 100 according to the tasks assigned to the student such as daily 
preparation, daily oral, monthly, or written exams, reports .... etc  

24. Learning and Teaching Resources  
Required textbooks (curricular books, if any) Dental laboratory technology by john  

B. Sowter 
- Acrylic  partial denture 

Main references (sources) Kratochvils Fundamental of Removable  
partial denture 

Atlas of Removable partial denture  

Recommended books and references 
(scientific journals, reports...) 

American dental journal 
- British dental journal 

Electronic References, Websites Lecture rooms providing guest service  
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Course Description Form 

1. Course Name: 
English language 

2. Course Code:  
 

3. Semester / Year: 
The first stage/ the annual system 

4. Description Preparation Date: 
29/3/2024          

5. Available Attendance Forms:  

My presence 

6. Number of Credit Hours (Total) / Number of Units (Total) 

Six hours for the first stage/6 

 

7. Course administrator's name (mention all, if more than one name)  

Name: ayah Adel Hashem 
Email: aya.adel.inj@atu.edu.iq 
 

8. Course Objectives  
Course Objectives 1- Providing students with practical skills in using medical terminology. 

2- Obtaining scientific knowledge and facts related to the English language 

curriculum and integrating it into scientific life 

3- Providing students with knowledge, scientific facts, information and their 

sources through scientific research. 

4- Using English as an educational means, facilitating human life, and increasing 

individual productivity. 
9. Teaching and Learning Strategies  

Strategy 1- Obtaining scientific knowledge and facts for the English language subject 

2- Preparing a vocabulary of special medical terminology for dental technicians 

3- Obtaining broad scientific facts and concepts in general and medical terminology in 

particular. 

10. Course Structure 
Week   Hours  Required Learning 

Outcomes  
Unit or subject 
name  

Learning 
method  

Evaluation 
method  

First 2 Future vocabulary 
 

Medical terms lecture Oral exam 

Second 2 Focus on reading 
Focus on writing 

Medical terms lecture Questions and 
discussion 

Third 2 Focus on writing Medical terms lecture Written test 



 

 

 
18 

 
  

Fourth 2 Medical terms Vocabulary 
development 
 

lecture homework 

Fifth 2 Focus on grammar 
 

Oral 
communication 
skills 

lecture Questions and 
discussion 

Sixth 2 Pronunciation of medical 
terms 
 

self evaluation 

 
lecture Oral exam 

Seventh 2 Develop writing skills 
 

Medical terms 

 
lecture Written test 

Eighth 2 Oral communication skills 
 

Vocabulary 
development 

 

lecture Oral exam 

Ninth 2 Review exercises 
 

evaluation lecture Questions and 
discussion 

Tenth 2 physique 
 

Major body systems 

 
lecture Written test 

Eleventh 2 Body positions 
 

Major body systems 

 
lecture homework 

Twelfth 2 Oral communication skills 
 

Review exercises 

 
lecture Oral exam 

Thirteenth 2 Body systems 
 

Vocabulary 
development 

 

lecture Questions and 
discussion 

Fourteenth 2 Written focus 
 

Medical terms lecture Written test 

Fifteenth 2 Pronunciation of medical 
terms 
 

Self-evaluation lecture homework 

11. Course Evaluation 
First Course: (25 Mid term + 70 final + 5 activities) 
Final grade: 100 marks 

12. Learning and Teaching Resources  
1- - Methodical books 
2- Summaries of the curriculum. 
3- Sources from the Internet as an addition to the curriculum. 
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25. Course Name: 
computer fundamentals 

26. Course Code:  
 

27. Semester / Year: 
The first stage  

28. Description Preparation Date: 
4  /4 /2024          

29. Available Attendance Forms:  

 

30. Number of Credit Hours (Total) / Number of Units (Total) 

          3/3 

31. Course administrator's name (mention all, if more than one name)  

Name: NOOR RAZZAK ABBAS 
Email: noor.hachame@atu.edu.iq 

 

32. Course Objectives  
Course Objectives 1- Providing students with practical skills in using the computer and its programs. 

2- Obtaining scientific knowledge and facts related to presentation 

 programs and preparing slides, databases, and tables. 

3- Providing students with knowledge, scientific facts, 

 information and their sources through scientific research. 

4- Using the computer as an educational means, facilitating human life, 

 and increasing individual productivity. 
33. Teaching and Learning Strategies  

Strategy 1- Obtaining scientific knowledge and facts about computer 

 science. 

2- Preparing slides and tables. 

3- Obtaining expanded scientific facts and concepts in general, 

 the Internet in particular. 

34. Course Structure 
Week   Hours  Required Learning Outcomes  Unit or 

subject 
name  

Learning 
method  

Evaluation 
method  

First 3/3 Phases of the computer cycle, its 
generations, Data and information 

Computer basics 

and office 

applications 

lecture Oral exam 

Second 3/3 Computer features 

, areas of use, and components 

Computer basics 

and office 

applications 

lecture Questions and 
discussion 

Third 3/3 Types of computers 

and their   

classification 

Computer basics 

and office 

applications 

lecture Written test 
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Fourth 3/3 Computer components, physical 
parts, input 
and output devices 

Computer basics 

and office 

applications 

lecture homework 

Fifth 3/3 1- Introduction to the Home tab 
2- Portfolio group 
A- Copy 
B- Cut 
C- Portfolio Tasks Pane 
D- Paste 
Y- Paste options 
T- Copy formats 

Computer basics 

and office 

applications 

lecture Questions and 
discussion 

Sixth 3/3 1- Calligraphy group 
A- Font, font size, font enlargement and zeroing, font 
color, bold, italic and underline, change case, text 
highlighting 
B- Text effects, clear formatting, strikethrough 
command, superscript and subscript command, font 
dialog box 
2- Paragraph group 
A- Alignment, indentation, using a ruler for 
indentation, line spacing 
B- Bullets, numbering, borders, shading, paragraph 
dialog box 

Computer basics 

and office 

applications 

lecture Oral exam 

Seventh 3/3 - Home tab, Styles group 
A- Apply heading styles to the text 
2- Home tab, Editing group 
A- Search 
B- Replacement 
C- Replace all 
D- Select text and objects 
3- Introduction to the Inserts tab 
A- A group of pages 
(blank page, cover page, page break) 

Computer basics 

and office 

applications 

lecture Written test 

Eighth 3/3 1- A group of tables 
A- Inserting a table, explaining the table’s contextual 
tabs, design and layout, entering table data, resizing 
and moving the table. 
2- Use the contextual Layout tabs to insert additional 
columns and rows, merge cells, split cells, convert text 
to a table, convert a table to text, and delete a table. 

Computer basics 

And office 

applications 

lecture Oral exam 

Ninth 3/3 1- Graphics group 
A- Insert an image, explain the formatting contextual 
tab, apply artistic effects, crop an image, wrap text, 
change the location of the image 
2- Insert clip art 

Computer basics 

and office  

applications 

lecture Questions and 
discussion 

Tenth 3/3 1- Inserting shapes, rotating, modifying and resizing 
shapes 
2- Insert a smart or illustrative figure 
3- Insert graphic charts 

Computer basics 

and office  

applications 

lecture Written test 

Eleventh 

 

 

 

 

 

3/3 1- Group of links 
A- Insert a link, delete a link 
2- Insert a bookmark, delete a bookmark 
3- Header and footer 
A- Add a header and footer to the document 
B- Close the header and footer sections 
C- Insert the page number 

Computer basics 

and office  

applications 

lecture homework 

Twelfth 3/3 1- Set of text and symbols 
A- Insert a text box, use WordArt, apply drop cap effects, insert 
date and time, use auto-refresh. 
B- Insert symbols 
2- Introduction to the Page Layout tab 

Computer basics 

and office  

applications 

lecture Oral exam 

Thirteenth 3/3 1- Page setup group 
A- Margins, text direction, size, columns, page numbers, and 
hyphenation 
2- Set the page background 
A- Add watermark, remove watermark 
B- Page frame 

Computer basics 

and office  

applications 

lecture Questions and 
discussion 

Fourteenth 3/3 1- Introduction to the References tab 
2- Table of contents set 
3- Collection of footnote notes 
4- Review tab 
5- Proofreading group (spelling and grammar 
checking) 

Computer basics 

and office  

applications 

lecture Written test 
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Fifteenth 

 
 
 
 
 
 

3/3 Practical exercises Computer basics 

and office  

applications 

lecture homework 

35. Course Evaluation 
First semester: (20 written + 15 practical + 5 activities) 
Second semester: (20written + 15 practical + 5 activities) 
Final: 60 marks 
Final grade: 100 marks 

36. Learning and Teaching Resources  
1- The four methodological books, (computer basics and office applications). 
2- Summaries of the curriculum. 
3- Sources from the Internet. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 




